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Executive Summary 
Large-Scale Particle Image Velocimetry (LSPIV) is a technique utilized by Reclamation and 
other entities to obtain surface velocity measurements both in field and laboratory settings. This 
study aimed to address three key points: 

1. What seeding material can be used to accurately represent the flow around objects of 
interest?  

2. What data collection technique provides the most accurate results for laboratory and field 
use?  

3. What are the best approaches to analyze collected data?  
 
To assess these questions, both laboratory and field testing were conducted. Laboratory testing 
occurred in Reclamation’s Hydraulics Laboratory. Field testing occurred at two river sites near 
Wenatchee, Washington. Between these locations, the following variables were tested: 

1. Four seeding materials and no seeding. 
2. Three camera frame rates.  
3. Two types of cameras.  
4. Two processing software packages.  

 
Results from this study indicate that both field and laboratory flow measurements required the 
addition of seeding material, even under turbulent conditions. Effective seeding materials 
included high-contrast, easily dispersible particles such as wood shavings, polystyrene spheres, 
and dark-colored water beads, all of which minimized clumping and enhanced particle visibility. 
Camera settings of 30 frames per second (fps) were sufficient for measuring velocities at or 
below 3 ft/s; at velocities higher than 3 ft/s frame rates greater than 30 fps, higher frame rates 
tended to produce artificially elevated velocity estimates. For velocities above 3 ft/s, a minimum 
framerate of 60 fps is necessary for accurate velocity estimates, with the overall goal for planar  
LSPIV for a particle to move approximately 2 pixels between frames. For current laboratory and 
field applications, PIVLab was identified as the preferred processing software, as TRiVIA was 
limited by its requirement for aerial video input. Future work should include the evaluation of 
Reclamation’s recently acquired LiDAR-compatible UAS system for LSPIV data collection, 
followed by a comparative assessment of available processing software. 
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1.0 Introduction 
Large-Scale Particle Image Velocimetry (LSPIV) is a technique utilized by the Bureau of 
Reclamation (Reclamation) and other entities to obtain surface velocity measurements both in 
field and laboratory settings. LSPIV differs from other techniques used to collect velocities in 
that it uses images to track particle movement, often seeding material such as foam beads in the 
lab or a biodegradable option in the field, over time. As this method of acquiring velocities is 
non-intrusive, it can be used in areas of interest that would be harder to access or are too shallow 
for other velocity measurement techniques. Additionally, in a laboratory setting, LSPIV allows 
for simultaneous velocity vector mapping of the water surface as opposed to point velocity 
measurements. Currently, Reclamation’s Hydraulics Laboratory uses LSPIV on physical 
hydraulic models and field studies that benefit from streamlined information about surface 
velocity data, such as habitat restoration and fish passage projects. However, there are issues 
with the LSPIV techniques currently being employed. Clumping of the seeding material and 
settings in the data collection process can skew velocity readings around key areas. This can 
result in less accurate information about the performance of fish passage and river restoration 
projects. Recently, new advances have been made in software processing packages including 
U.S. Geological Survey’s (USGS) recently released TRiVIA. This project aims at testing LSPIV 
techniques from seeding material to data processing, ensuring that best practices are being 
utilized. 
 

1.1. Previous Work  
LSPIV has been used on many physical hydraulic models and field studies. To best demonstrate 
the gaps in this technique, two main projects are cited: Reclamation Science and Technology 
S&T project ID 1726 (Holste, et. al. 2019) and Hydraulics Laboratory report HL-2020-10 
(Shinbein, 2020). These studies looked at the effects of boulder clusters in the Los Angeles River 
for fish resting and passage. While the velocity vector data from a physical model around 
boulder clusters could be observed for general trends, it was difficult to discern quantitatively 
reliable velocity values. Additionally, the significant clumping of seeding material around the 
boulder clusters resulted in some skewed velocity vectors at areas of recirculation, which are a 
key area of interest for fish passage. Results from PIVLab were taken into TecPlot to generate 
velocity maps of acceptable areas for fish resting zones, moderate resting zones, and not 
acceptable zones where velocities were too high for resting. While this was helpful to view, it 
was still difficult to discern what was happening between the boulders that comprised the 
boulder cluster. 
 
For these laboratory projects, polystyrene beads were uniformly introduced into the physical 
model by using a leaf blower. The seeded water surface was recorded for a minimum of 10 
seconds using a GoPro at 30 fps. The frames from the video were extracted using RIVeR and 
processed to generate velocity maps in PIVLab. In a more recent project, output from PIVLab 
was processed through TecPlot and then overlaid on an image of the physical model. This was 
significantly more useful in observing surface velocity trends relative to critical infrastructure 
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proposed in the model versus prototype. However, while data presentation techniques have 
improved, the key problems of LSPIV still remain. Both studies used PIVLab as the primary 
software package, which has not been updated since 2017. Newer versions of PIVLab software 
are now available. Additionally, clumping of seeding material around areas of recirculation and 
due to static electricity between the particles can skew velocity readings in those areas. Refining 
LSPIV techniques will prove useful for future physical models and field data collection efforts.  

1.2. Objectives  
The research aimed to address three key points: 

1. What seeding material can be used to accurately represent the flow around objects of 
interest? This project tested three different materials often used by Reclamation and 
similar entities.  

2. What data collection technique provides the most accurate results for laboratory and field 
use? This project tested three different techniques for distributing seeding material at 
three different flow rates. 

3. What are the best approaches to analyze collected data? This project investigated two 
different software packages. 

  
 
To answer these questions, first a literature review was conducted. Second, both field and 
laboratory LSPIV site data were collected. This data was collected simultaneously with other 
velocity data collection techniques, including Acoustic Doppler Velocimetry (ADV) and Nixon 
meter velocity measurements. Finally, the data was processed using two different readily 
available software packages.  

2.0 Literature Review  
The literature review for this project focused on ascertaining best practices for LSPIV data 
collection and analysis. For this reason, data sources were varied, as LSPIV is a wildly used 
technique. The main results of the literature review for particle seeding were as follows:  

1. In highly turbulent flow, seeding material was often omitted from data collection with 
success. Instead of seeding material, natural elements such as air bubbles, sunlight, and 
aerated flow within the footage were used (Fujita, 1998. Hauet, 2007/2008; Creutin, 
2003). 

2. Many used high color-contrast plastic beads or eco-foam of differing sizes and colors 
(Fujita, 1998; Sutarto, 2015; Braat, 2018; Leuven, 2019/2020).  

3. Light floating debris, ice blocks, ground black pepper, and saw dust were also 
successfully used as more natural alternatives to the plastic beading (Muste, 2008/2014).  

 
For a comprehensive list of all literature assessed during this review, please see Appendix C.  
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From these results, the laboratory and field test matrix were shaped to try a range of different 
seeding material, data collection tools, and processing software. Given the demonstrated success 
of others in using turbulent water without seeding material, each field site was tested both with 
and without seeding material to evaluate the necessity of seeding in typical environmental 
conditions. For laboratory testing, three seeding materials were selected based on the ease of 
recapturing the material or the ability of the material to break down naturally without capture in 
the laboratory. For both field and laboratory testing, different frame rates and processing 
software were utilized. A result of this study includes workflows generated for two different 
processing software products for future needs. These can be found in Appendices A and B.  

3.0 Laboratory Testing  
Laboratory testing was conducted at the Bureau of Reclamation’s Hydraulics Laboratory in a 
physical hydraulic model of a river system. This model was selected due to the open flow 
channels. Additionally, this model contained rocks, which tested how the seeding material 
performed in recirculating areas and would be more similar to field applications.  

3.1. Methods  
In the lab, three different seeding materials were tested in the same physical hydraulic model. 
These materials were:  

1. Polystyrene beads – these beads are the current seeding material used by the Hydraulics 
Laboratory for LSPIV.  

2. Water beads – these are gel-like beads that expand and become buoyant when soaked in 
water. These beads come in a variety of different colors. For this test, all colors (red, 
green, and black) were combined in one bulk container.  

3. Dyed ice cubes – ice cubes were dyed dark purple. The idea was that the ice cubes would 
melt and thus not require capture.  

  
The seeding material was dispersed by a leaf blower, small pre-measured quantities 
simultaneously, and all at once further upstream in the model. As the leaf blower only worked 
for the polystyrene beads, this dispersion method was not compared. Seeding material was 
introduced where flow entered the model (at the bottom of the figures presented in section 3.2.1) 
for a minimum of 10 seconds, continuously.  
 
All data was collected using a GoPro camera. However, the frames per second (fps) were 
changed during testing from 30 fps to 60 fps to ascertain if increasing the frame rate improved 
the data collection capabilities of the GoPro camera. Data were processed using RIVeR, PIVLab, 
and TRiVIA. Separate velocity data was collected using a Nixon Meter for comparison to LSPIV 
data. RIVeR takes the initial video data and pulls out each individual frame of the video for a 
given span of time. RIVeR was consistently used for all video datasets as it is the most efficient 
and easy-to-use software for this purpose. 
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PIVLab is software currently utilized by Reclamation for LSPIV processing needs. Previous data 
processing efforts were completed using a version of the software that was released in 2017. A 
newer version of PIVLab has been released as recently as 2024. The newest version of the 
software was used during this research project. During processing, a velocity vector map of the 
mean velocities throughout the duration of the video is produced. These are the maps used in the 
final figures as they provide the most coherent trends. The downside of PIVLab velocity vector 
mapping is the only units available for processing are in metric. To convert to English units, data 
must be exported to Microsoft Excel, converted to English units, and processed again in TecPlot. 
As this is a known process, it was omitted from the study to focus on software improvements.  
 
The Toolbox for River Velocimetry using Images from Aircraft (TRiVIA) was released in 2023 
as a processing interface created by the USGS for processing LSPIV software from unmanned 
aerial systems (UAS). At the time of this project, Reclamation did not possess a UAS capable of 
collecting LSPIV data. However, as this software showed promise in processing large LSPIV 
datasets, it was decided to test this software. As part of this study, workflows were created for 
both the newest version of PIVLab and TRiVIA. These can be found in Appendix A and B.  

3.2. Results 

3.2.1. Differing Material and Frame Rates  

Polystyrene beads are the currently utilized seeding method in Reclamation’s Hydraulics 
Laboratory. Issues with this seeding material include clumping due to static electricity produced 
by the beads in the leaf blower, difficulty in recollecting the beads, and the non-degradability of 
the plastic. While testing this material, 5-gallon containers that did not generate a charge were 
used. Notably, clumping was not as pronounced as previously seen in other models which was 
likely due to the supercritical flow regime in the tested physical model. As the seeding material 
moved from the entrance to the model to the exit (bottom to top of Figure 1), velocity data was 
generated for 30 and 60 fps. The 60 fps test was able to capture the side channels in the model 
better than the lower frame rate; however, resolution was lost further downstream. Compared to 
the velocities collected using the Nixon meter, the upstream and right side of the image agreed 
more with the 60 fps tests as those areas exceeded 3 ft/s (shown as red in the image). 
Downstream velocity measurements showed greater agreement with the 30 fps scenario. This is 
potentially due to the lower than 3 ft/s velocities seen in those sections of the model (Figure 1). 
Overall, modifications can be made to improve the dispersion and recollection techniques for the 
polystyrene beads.  
 
Ice cubes proved to be an ineffective seeding material for laboratory flow visualization due to 
significant challenges in distribution and stability. They were initially selected because they 
would melt without generating the cleanup issues associated with polystyrene beads. However, 
the same property that made ice cubes appealing ultimately limited their utility. As ice cubes 
were dyed to increase contrast, a requirement for seeding material, they would immediately 
begin to melt. Thus, by the time the ice cubes were distributed in the model, it was difficult to 
distinguish discrete particles from the dye plumes created by melting. This issue not only 
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reduced the number of trackable tracers but also degraded overall image clarity, complicating the 
software’s ability to resolve coherent velocity vectors. Therefore, velocity maps generated from 
the ice cube tests are not reliable (Figure 2). Although the velocity maps generated at the 60 fps 
test scenario were consistent with Nixon meter measurements, the accuracy and clarity of the 
results were compromised by ice cube melting, non-uniform seeding dispersion, and dye 
leaching, which obscured the field of view. A potential improvement for ice cubes could include 
purchasing a separate ice maker to generate smaller, pre-dyed ice cubes. Until such 
modifications are implemented, however, ice cubes are not recommended as a primary seeding 
material for LSPIV applications. 
 
Water beads, sometimes known by the brand name “Orbeez”, had the same recollection and 
distribution problems as polystyrene beads. Once in the water column, water beads are naturally 
buoyant and due to the deformable and delicate consistency, they were difficult to recollect 
without breaking the beads. Additionally, water beads need to be presoaked in order to expand to 
the correct buoyancy. This means that distribution techniques that use electric components, such 
as leaf blowers, could not be used without risk of damaging the battery or internal electrical 
components. Significant deviations between 30 and 60 fps were caused by the concentration of 
darker color water beads (Figure 3). In the 30 fps scenario, much of the velocity flow data is 
missing from the upstream portion, bottom part of the frame, of the data. As darker water beads 
were used, velocity data becomes clearer at the 60 fps scenario. Additionally, in the portion of 
the model where velocities exceed 3 ft/s (shown as red in the velocity map), the 60 fps map has 
higher agreement with the Nixon meter velocity data. Therefore, only high-contrast color water 
beads should be used. Additionally, as less water beads are used than polystyrene beads, a higher 
frame rate is needed to correctly capture the velocity data and generate correct velocity field 
maps.  
 
As other seeding options were not viable for immediate use without significant changes to every 
aspect of implementation, it is worth simply improving the re-collection techniques for the 
polystyrene beads. Modifications can include adding dryer sheets to remove the static charge 
from reused beads.  
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Figure 1. PIVLab outputs of the mean velocity vector mapping at 30 and 60 fps (right) using 
polystyrene beads. Flow moving from the bottom of the frame to the top. Note: red areas at the edge 
of the colored velocity maps are masked and excluded from processing.  
 

 
Figure 2. PIVLab outputs of the mean velocity vector mapping at 30 fps (left) and 60 fps (right) using 
dyed ice cubes. Flow moving from the bottom of the frame to the top. Note: red areas at the edge of 
the colored velocity maps are masked and excluded from processing. 
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Figure 3. PIVLab outputs of the mean velocity vector mapping at 30 fps (left) and 60 fps (right) using 
water beads (Orbeez). Flow moving from the bottom of the frame to the top. Note: red areas at the 
edge of the colored velocity maps are masked and excluded from processing. 
 

4.0 Field Testing 
Field testing for LSPIV data collection techniques occurred at the Wenatchee and Entiat Rivers 
in central Washington. The Wenatchee River recently underwent modifications to the channel to 
include boulder clusters and large woody debris jams for fish passage and habitat.  

4.1. Methods  
As the field testing was on an open river with no way of re-collecting dispersed seeding material, 
environmentally friendly options were used. These materials included:  

1. No seeding material – as the flow surrounding the boulder clusters was turbulent, it was 
decided to attempt to collect LSPIV data without any material added.  

2. Wood shavings – cedar wood shavings were buoyant, easy to find in local stores, and 
easy to distribute. All figures presented use wood shavings as the seeding material.  

3. Natural leafy material – similar to wood shavings, it was thought that leafy material 
would be easy to find and, as it would come from the banks of the river, would not pose 
an environmental risk. However, this material was extremely difficult to distribute and, as 
such, was not used for more than one trial.  

 
The material was all dispersed by hand, upstream of the features of interest so as to not disrupt 
the flow around the features. Data collection used both GoPro cameras and government-issued 
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iPads at 30, 60, and 120 fps. Additionally, several different field of views were trialed using an 
iPhone 15 Pro at the same location. This included introducing distortion via the zoom out feature 
to test distortion correction algorithms in RIVeR and PIVLab software packages. 
 
As part of this process, two different software products were tested:  

1. PIVLab – this was the software used within Reclamation’s Hydraulics Laboratory at the 
start of this project. However, the version previously used was issued in 2016. As part of 
this study, the software was updated to the 2024 version to test the new features included 
in those updates.  

2. TRiVIA – the Toolbox for River Velocimetry using Images from Aircraft was created by 
USGS to process LSPIV data from aircraft such as UAS.  

3. LSPIV processing app available on iPad called “LSPIV” – this approach was considered 
however, it was not clear how this data would be protected in using the internet 
connected app. Therefore, it was decided not to use this software.  

 
Similarly to the laboratory testing, the software RIVeR was used to extract frames from all 
videos. Additionally, separate velocity data was collected using an ADV (Flow-Tracker 2) to 
compare LSPIV data. While the ADV is used to collect velocities at approximately 60% of the 
water depth and LSPIV is velocity data at the surface, the data was used as a basis of 
comparison.  

4.2. Results 

4.2.1. Differing Frame Rates  

Looking at the mean velocity field maps (Figure 4 and Figure 5):  
• These images represent mean velocity vectors collected over the duration of the video. 

All videos were seeded with wood shavings and were tested at 120, 60, and 30 fps.  
• Velocity trends are consistent for all tested frame rates. However, 60 fps skewed towards 

representing the velocities as higher when compared to 120 and 30 fps in the same area, 
particularly to the left and right of boulders where some turbulence would cause flow to 
naturally accelerate in that area.  

• There are some variances in streamlines, partly due to the way they are specified 
manually in the software.  

• Big flow features (e.g., boulders) are captured well in all three frame rates. Streamlines 
where flows are particularly low, such as downstream of boulders, show up best in 30 
fps. Flow immediately downstream of rocks recirculated due to the boulder acting as a 
large obstruction in the flow field. At the higher frame rates, this recirculation created 
noise in the streamlines, represented as extra spiral lines.  

 
Looking at the velocity scatterplots (Figure 4 and Figure 5):  

• 120 fps had the highest frequency of single-point outliers, represented as individual 
points in the velocity scatterplot. This can be minimized by using PIVLab’s velocity 
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range selection tool, however differentiating true outliers from relevant data remains 
challenging.  

• 60 fps had the widest range of velocities in the x-direction. This is represented as the 
darker red in the imagery and was originally thought to be human error in seed 
distribution. However, this trend was consistent in multiple tested scenarios.  

• 30 fps had the tightest scatter in both the x- and y-directions.  
These velocity histogram trends were consistent for all tested scenarios. Therefore, having an 
idea of the known range of velocities is key in selecting the frame rate. Velocities under 3 ft/s, 
the most common range for subcritical riverine environments where it is safe for wading and in 
the laboratory, should use 30 fps to provide the best results.  

 
Figure 4. PIVLab outputs of the mean velocity vector mapping at 120 (left), 60 (center), and 30 fps 
(right) with velocity scatterplot. Video was collected using a GoPro HERO 10. Flow moving from the 
bottom of the frame to the top. Note: red area in the center of the image is masked, or excluded from 
processing, and represents where the camera was mounted in the frame.  
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Figure 5. PIVLab outputs of the mean velocity vector mapping at 120 (left), 60 (center), and 30 fps 
(right) with velocity scatterplot. Video was collected using a GoPro HERO 10. Flow moving from the 
bottom of the frame to the top. Note: red area in the center of the image is masked, or excluded from 
processing, and represents where the camera was mounted in the frame. 
 

4.2.2. With and Without Seeding  

Seeding for this study consisted of local plant-based material, such as fallen leaves, and 
purchased wood shavings. All materials were selected to be bio-degradable and nonobtrusive to 
wildlife. For this comparison, all camera settings remained constant with all data collected on 
one continuous video. Leafy debris was often of an inconsistent size and shape, making it 
difficult to evenly distribute and was thus eliminated from repeated use.  
 
The rivers used in the field portion of this study were not turbulent enough and did not have 
natural surface flow variation to support LSPIV analysis without the addition of seeding 
material. In unseeded conditions, the lack of distinct surface tracers limited the ability of the 
PIVLab to identify coherent particle motion, resulting in poor correlation between image pairs. 
This can be seen through a few different outputs in Figure 6 and Figure 7:  

1) Streamlines are represented in PIVLab by solid white lines running parallel to the flow. 
For the “no seed” conditions, streamlines were either not possible to generate or start/stop 
in sporadic patterns instead of linearly around the boulders.  

2) In the velocity scatterplots, for seeded conditions, there is a much tighter and clearer 
pattern of where the majority of the velocity points are. 

3) While some of the near-field videos were able to produce velocity fields in the highest 
turbulent areas, all ability to produce velocity data was lost further downstream.  

 



 
Methodology Assessment for  

Large-Scale Particle Image Velocimetry 
 

 
 

11 

These results highlight the necessity of artificial seeding in low-turbulence rivers to ensure 
adequate particle density for robust cross-correlation and accurate velocity extraction. 
 

 
Figure 6. PIVLab output of the mean velocity vector mapping without (left) and with (right) seeding on 
one cluster of rocks. Video collected with a GoPro HERO 10. Flow moving from the bottom of the 
frame to the top. Note: red area in the center of the image is masked, or excluded from processing, 
and represents where the camera was mounted in the frame.  
 

 
Figure 7. PIVLab output of the mean velocity vector mapping without (left) and with (right) seeding on 
a separate cluster of rocks on a different day. Video collected with a GoPro HERO 10. Flow moving 
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from the bottom of the frame to the top. Note: red area in the center of the image is masked, or 
excluded from processing, and represents where the camera was mounted in the frame.  

4.2.3. Cell Phone Videos  

While at the Wenatchee site, video was collected using an iPhone 15 Pro. Video was collected 
from the same boulder location as video collected using the GoPro, however, at a much lower 
height as the GoPro was able to be raised on an extendable rod. The iPhone video was collected 
with and without distorted settings enabled. Without distorted settings enabled, or simply a 
regular video, the iPhone was able to capture video with good agreement to ADV data, with 
velocities downstream of the boulder matching within 0.1 ft/s (Figure 8).  
 
Both RIVeR and PIVLab include built-in tools to correct distortion from a video. Therefore, to 
increase the field of vision of the camera, it was decided to collect iPhone data with the zoom out 
feature enabled on the camera. This creates a “fisheye” effect in the video, with higher amounts 
of distortion at the edges of the field-of-view. When correcting this distortion during post-
processing, known ground coordinates are input into the software to help the program flatten, or 
correct for, the distortion in the video. However, there was no significant difference between 
images with and without the distortion correction feature enabled (Figure 9). Therefore, 
distortion should not be used in collecting LSPIV data without more refined georeferenced tie-in 
points in 3D coordinate planes.  
 
In all, LSPIV data could successfully be collected and then processed with video from a 
smartphone under specific conditions. These conditions require seeding and no distortion, and it 
should be noted that the end result will have a much narrower field of view. Therefore, these 
limitations indicate that while smartphones may serve as a viable backup when dedicated 
equipment is unavailable, they should not be considered the primary tool for high-accuracy 
LSPIV data collection.  
 

 
Figure 8. PIVLab outputs from an iPhone 15 Pro with seeding. Flow 
is moving from right to left. Note: red area in the center of the 
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image is masked, or excluded from processing, and represents 
where the camera was mounted in the frame. 
 
 
 

 
Figure 9. PIVLab output using cell phone at zoomed out (0.6x) distorted setting with (left) and without 
(right) correction for distortion. Flow is moving from right to left. Note: red area in the center of the 
image is masked, or excluded from processing, and represents where the camera was mounted in the 
frame.  

4.2.4. Results from TRiVIA  

Since all data collected as part of this project utilized close cameras such as GoPro and iPhones, 
it was not the ideal use-case for TRiVIA. However, it was decided to proceed with this 
processing method to see if it could still be applied. Similarly to PIVLab, LSPIV data was 
processed with and without seeding material (Figure 10). This was the same case as tested in 
PIVLab (Figure 7). Unfortunately, due to the nearfield data collection, TRiVIA was not able to 
produce full flow-field results as observable by the blank (white) areas in Figure 10.  
 
In June 2025, Reclamation met with the USGS employees who produced TRiVIA to see if the 
application could be further refined. Since close camera data collection was not the intended use 
case, there was not much that could be done to refine the output. USGS employees recommend 
collecting data via UAS or aircraft when using TRiVIA software. Therefore, future work should 
be expanded to test TRiVIA outputs with the correct data collection method.  
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Figure 10. TRiVIA output without (left) and with (right) seeding.  

5.0 Conclusions and Future Work 
Large-Scale Particle Image Velocimetry (LSPIV) is a technique currently used by Reclamation 
and other entities to measure surface velocities. This process records particle movement, often 
referred to as seeding material, at the water surface using video recording devices such as GoPro 
cameras. From there, frames of the video are extracted and put through a processing software 
that traces each particle’s pathway along the water surface over a known distance. This is used to 
derive the velocity of each particle, creating velocity maps and streamlines across the surface of 
interest. Currently, Reclamation’s Hydraulics Laboratory uses software called PIVLab and 
polystyrene bead material. 
 
As part of this project, both field and laboratory sites were tested. For the field testing, LSPIV 
data was collected both with and without seeding material, and at 30, 60, and 120 fps using a 
GoPro and phone cameras. For laboratory testing, LSPIV data was collected with three unique 
seeding materials via three dispersion techniques at 30 and 60 fps using a GoPro camera. Both 
datasets were processed using PIVLab and TRiVIA software.  
 

• For seeding material: the polystyrene beads were the easiest and most effective at 
covering a large area within the physical hydraulic model. However, dark water beads 
were an effective alternative. In the field, even with turbulent flow, seeding material was 
still necessary. Wood shavings were an effective and easy to source biodegradable 
seeding material.  

• For data collection: the GoPro at 30 fps is best for velocities under 3 ft/s. Using higher 
frame rates skewed the velocities higher than what corresponding velocity data collected 
via other means showed at the same location. For velocities above 3 ft/s both the 120 and 
60 fps on a GoPro can work well to collect accurate data.  
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• For data processing: PIVLab is better suited for laboratory use. It is also preferable for 
field data when data is collected using a camera such as a GoPro mounted on an 
extendable rod or mobile device cameras, when needed.  

As PIVLab had new software components compared to previous versions and TRiVIA was an 
entirely new software package, new workflows were also created as part of this project for ease 
of future use and training.  

5.1. Future Work  
During the span of this project, Reclamation acquired a Wingtra fixed wing UAS. This UAS is 
LiDAR capable and thus can collect river sections of LSPIV data. Future LSPIV work should 
include attempting to collect and process LSPIV data with the Wingtra, both in PIVLab and 
TRiVIA. Other future work should include testing air-entrained flow for use as a tracer in 
LSPIV. Additionally, LSPIV should be tested in tandem with other data collection techniques 
such as infrared cameras for simultaneous velocity and scalar measurements. Finally, better 
quantifying error and uncertainty associated with LSPIV data collection techniques can continue 
to refine this technique. 



 
Methodology Assessment for  

Large-Scale Particle Image Velocimetry 
 

 
 

17 

6.0 References 
For Literature Review:  
Braat, Lisanne, Jasper R. F. W. Leuven, Ivar R. Lokhorst and Maarten G. Kleinhans. September 
10, 2018. “Effects of estuarine mudflat formation on tidal prism and large-scale morphology in 
experiments”. Earth Surface Processes and Landforms.  
 
Buscombe, D., et. al. January 29, 2024. “Remote Sensing Large‐Wood Storage Downstream of 
Reservoirs During and After Dam Removal: Elwha River, Washington, USA”. Earth and Space 
Science.  
 
Creutin, J.D., et. al. February 20, 2003. “River gauging using PIV techniques: a proof-of-concept 
experiment on the Iowa River”. Journal of Hydrology.  
 
Fujita, Ichiro, Marian Muste, and Anton Kruger. 1998. “Large-scale particle image velocimetry 
for flow analysis in hydraulic engineering applications”.  
 
Hauet, Alexandre, Jean-Dominique Creutin, and Philippe Belleudy. October 25, 2007. 
“Sensitivity study of large-scale particle image velocimetry measurement of river discharge 
using numerical simulation”. Journal of Hydrology.  
 
Hauet, Alexandre, et. al. 2008. “Experimental System for Real-Time Discharge Estimation Using 
an Image-Based Method”. ASCE.  
 
Johnson, Erika D. January 2015. “THE REMOTE MONITORING OF SURFACE VELOCITY, 
BATHYMETRY AND DISCHARGE IN RIVERS AND OPEN CHANNEL FLOWS”. 
Dissertation. 
 
Johnson, E.D. and E.A. Cowen. February 16, 2016. “Remote monitoring of volumetric discharge 
employing bathymetry determined from surface turbulence metrics”. Water Resources Research.  
 
Legleiter, Carl J. and Ryan L. Fosness. March 19, 2019. “Defining the Limits of Spectrally 
Based Bathymetric Mapping on a Large River”. Remote sensing.  
 
Legleiter, Carl J. and Lee R. Harrison. December 17, 2018. “Remote Sensing of River 
Bathymetry: Evaluating a Range of Sensors, Platforms, and Algorithms on the Upper 
Sacramento River, California, USA”. Water Resources Research. 
 
Legleiter, Carl J. and Paul J. Kinzel. January 3, 2024. “A framework to facilitate development 
and testing of image-based river velocimetry algorithms”. Earth Surface Processes and 
Landforms. 
 
Leuven, J.R.F.W., et. al. March 25, 2020. “Growing Forced Bars Determine Nonideal Estuary 
Planform”. Journal of Geophysical Research: Earth Surface.  



 
Methodology Assessment for  
Large-Scale Particle Image Velocimetry 
 

 
 
18 

 
J. R. F. W. Leuven and M. G. Kleinhans. May 22, 2019. “Incipient Tidal Bar and Sill 
Formation”. Journal of Geophysical Research: Earth Surface. 
 
M. Muste, I. Fujita, and A. Hauet. 2008. “Large-scale particle image velocimetry for 
measurements in riverine environments”. Water Resources Research.  
 
Muste, M., et. al. May 15, 2014. “Capabilities of Large-scale Particle Image Velocimetry to 
characterize shallow free-surface flows”. Advances in Water Resources.  
 
Sutarto, Tommy Ekamitra. 2015. “Application of large-scale particle image velocimetry (LSPIV) 
to identify flow pattern in a channel”. ScienceDirect.  
 
 
Software references:  
Legleiter, C.J., 2025, TRiVIA - Toolbox for River Velocimetry using Images from Aircraft (ver. 
2.2.1, July 2025): U.S. Geological Survey software release, https://doi.org/10.5066/P9AD3VT3. 
 
Patalano, A., García, C. M., & Rodríguez, A. 2017. “Rectification of Image Velocity Results 
(RIVeR): A simple and user-friendly toolbox for large scale water surface Particle Image 
Velocimetry (PIV) and Particle Tracking Velocimetry (PTV)”. Computers & Geosciences, 105, 
103–114. https://doi.org/10.1016/j.cageo.2017.05.006 
 
Thielicke, W., Sonntag, R. 2021. “Particle Image Velocimetry for MATLAB: Accuracy and 
enhanced algorithms in PIVLab.” Journal of Open Research Software, 9: 12. DOI: 
https://doi.org/10.5334/jors.334 
 
Previous Work  
 
Holste, Nathan and Melissa Shinbein. September 2019. “Design and Analysis of Ecosystem 
Features in Urban Flood Control Channels”. Science and Technology Program 1726.  
 
Shinbein, Melissa and Nathan Holste. November 2020. “Physical Model Testing of Boulder 
Cluster Configurations”. California-Great Basin Regional Office. HL-2020-10.  
 

https://doi.org/10.5066/P9AD3VT3
https://doi.org/10.1016/j.cageo.2017.05.006
https://doi.org/10.5334/jors.334


 

 

Appendix A 

Updated RiVER and PIVLab Processing Workflow  
 
 
 



  Methodology Assessment for  
Large-Scale Particle Image Velocimetry 

Appendix A 
 

 
 

A-1 

PIVLab and River Quick Guide 
Created by Bohman, Larry R., last modified by Engel, Frank on Dec 18, 2017  
Edited by Shinbein, Melissa, on April 18, 2024.  

 
RIVeR Software  
See also: http://riverdischarge.blogspot.com/p/tutorial.html  
 

Setup 
Since RIVeR is a compiled freeware made in the Matlab environment you should:  

• Download and install the Matlab Runtime version #R2015a (64-bit) 
>>>Note from Kit, I had to download and install version #R2015b (64-bit) to get RIVeR and 

PIVLab to work. 
• Download the latest version of RIVeR. Note, it takes a while for the .exe to open, so give it a 

minute.  
 

File location/structure: RIVeR cannot process data when in long path files with spaces. Put all folders on 
the C-Drive (local desktop) while working with the data.  
 

• Decide on a 10-second cut of a longer video (an entire video should be 30-60 seconds). I highly 
recommend documenting what 10-second cut you decide on using.  

 

Pulling Frames from Video  
In RIVeR: File ► Extract Images From File (note that filenames CANNOT have imbedded spaces) 
Click on the target video file, then OPEN. 
 

• Decide on fps (want 15 -25 pixels displacement per pair of images). I have personally found the 
best results to be with using all 30 fps. 

 
Appendix A-  1. RiVER frame extraction pop up.  
 

https://my.usgs.gov/confluence/display/%7Elrbohman@usgs.gov
https://my.usgs.gov/confluence/display/%7Efengel@usgs.gov
https://my.usgs.gov/confluence/pages/diffpagesbyversion.action?pageId=583664717&selectedPageVersions=1&selectedPageVersions=2
https://my.usgs.gov/confluence/display/SurfBoard/How+to+process+a+video+with+RIVeR+Software
http://riverdischarge.blogspot.com/p/tutorial.html
http://riverdischarge.blogspot.com.ar/p/download.html
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Selecting either Grayscale or Color are equally okay but sometimes using grayscale helps with contrast. 
Using Grayscale purportedly increases processing times. Actually, PIVLab will convert to grayscale in the 
background even if you don't. I often process in color so I can see what I'm doing better. 
 
Click on "Extract Frames" You'll note the directory with the video now has all the still frames. 

PIVLab  
Resources: https://www.pivlab.de/; https://www.youtube.com/watch?v=g2hcTRAzBvY  
  

Setup 
Input Data ► Import Images  
 

 
Appendix A-  2. PIVLab prompts for importing images.  
 
Browse (button on middle right). Navigate to FOLDER where sampled images exist. Select folder.  
 
Select the following image sequencing style: Time resolved: [A+B], [B+C], [C+D].  

• FYI, the other sequence style is used for "classical PIV" which traditionally had 2 cams that were 
time synced to take pics one after the other (because they couldn't go as fast with 1 cam). That's 
less important/irrelevant with one camera, and our applications. 

 
Select all images (Ctrl+a). Click Add. Select Import. 

• The image list on the panel on the right side displays the images that you selected. The letters 
'A' & 'B' denote the first and the second image of one image pair (= one "frame"). In the lower 
right corner, you will find a slider to navigate through all frames, and a button (Toggle A/B) to 
toggle between the individual images within one frame. 

 
Image settings ►Define Region of Interest (ROI).  

• You don't have to have an ROI or Masks, but it will dramatically speed up processing if you 
exclude "not water". Also, if you don't specify ROI/Mask, you can, and likely will get velocity 
vectors in regions where there is not water. 

https://www.pivlab.de/
https://www.youtube.com/watch?v=g2hcTRAzBvY
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Select ROI and then draw a box that encompasses all your reference points (see green-dash area 
below). Use "Clear ROI" if want to re-draw or click and drag from the corner of the box for different 
extents. The entire extent box can also be moved from the corners.  
 
Image settings ►Define masks to exclude region from analysis.  

• Use Polygon for weird shapes. Double click to close the loop. Repeat this step for the other 
areas you do not want processed within your ROI.  

• Mask areas that you anticipate may move during the time of analysis (such as people or 
vegetation). You may also mask areas you do not anticipate moving (banks or rocks) to save on 
some processing time, but I have found the difference to be minimal.  

 
Appendix A-  3. Imported image showing region of interest for PIVLab.  
 
Click on Copy mask to all frames (you won't notice any action) 
 
Image Settings ► Image Pre-processing: Contrast-limited adaptive histogram equalization (CLAHE) is 
enabled by default. This filter locally enhances the contrast in the images. Highpass filtering is also 
commonly used. Play around with the settings to see how the filters affect the image. Your goal is to 
produce an image with as much contrast of the moving bits in each Frame as possible. For now, enable 
CLAHE (20 pix window) and highpass filtering (15 pix window). MDS note: I have had fine results without 
using the highpass filtering. Do as you please.  
 
Apply and Preview Current Frame (will get result as shown below): 
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Appendix A-  4. Sample pre-processed output from PIVLab.  
Calibration ► Calibrate using current or external image  
Pick Reference Length [px]. It will have you draw a line across your point of interest and fill in the 
related real distance in mm and time step in ms boxes. Length must be in mm. 
 

 
Appendix A-  5. Calibration example.  
 
The time step calculation is as follows:  

𝑋𝑋 
𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠
𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓

∗ 1000 = 𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡 𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠 𝑖𝑖𝑖𝑖 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 

 
Example:        1

30 𝑓𝑓𝑓𝑓𝑓𝑓
∗ 1000 = 34.4𝑚𝑚𝑚𝑚 
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Please note, if you use RiVER to generate your stills from the video: RiVER generates a .txt file 
named “Images_Extraction”. This file contains the frames per second (fps) of the video and the 
time step in millisecond. You can use this instead of calculating the milliseconds. See below 
picture for example.  
 

 
Appendix A-  6. Sample output file from RiVER.  
 
Hit Apply calibration.  
 
Analysis 
Analysis Settings ► PIV Settings  

• To setup the cross-correlation for your image data. PIVlab features two different correlation 
algorithms, DCC (single pass direct cross correlation) and FFT window deformation (direct 
Fourier transform correlation with multiple passes and deforming windows). 

• Leave Multipass FFT window deformation in PIV algorithm box checked as is. Using this 
algorithm, your data will be analyzed in several passes: The first pass uses relatively large 
interrogation areas to calculate the displacement of your image data reliably. The larger the 
interrogation areas, the better the signal-to-noise ratio, and the more robust is the cross 
correlation. But large interrogation areas will only give a very low vector resolution ("vectors per 
frame"). That is why you should decrease the size of the interrogation windows in the following 
passes. The displacement information of the first pass is used to offset the interrogation areas in 
the second pass and so on. This procedure yields a high vector resolution, a high signal-to-noise 
ratio, and a high dynamic velocity range. Start with big interrogation areas (e.g. 128 pixels) and 
decrease gradually in the following passes (e.g. 64 pixels in pass 2). 

 
Change Pass 1 from 64 to 128 and 32 ◊ 64. We want displacement to be half the interrogation area (or 
less). For most videos of rivers, I seem to get good results with 3 passes, 128, 64, 32 (however, the 
previous recommendation was up to 256. Do as you please).  
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Appendix A-  7. Input for analysis (left) and sample image of pass sizing (right).  
 
Analysis ► Analyze! ►click on Analyze Current Frame if you would like to test and modify anything 
before. Otherwise, click on Analyze all frames. On the left side of the screen, it will give you updates on 
total progress and time left.  
 
After processing is complete, to change the vector scales go to: Plot► Modify Plot Appearance 
►change the vector scale 
  

 
Appendix A-  8. Plot appearance prompt in PIVLab.  

 
Post Processing  
Validation ► Vector Based Validation  
 
Check the box that says Display All Frames in Scatterplot 
 
Click on Select Velocity Limits 
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Draw box around the densest part of the data-point cluster (left click – hold – release).  
 

 
Appendix A-  9. Sample velocity scatterplot generated by PIVLab.  
 
Click on Apply to All Frames button (wait, % done displayed) 

 
Output 
Plot ► Temporal Parameters then click on the Calculate Mean Vectors button.  

• Now, an additional frame will be automatically added to your session. All masks of the frames 
you used to calculate this average will be combined. Vectors will be orange in the average 
frame, if more than half of the original vectors at that spot were interpolated before. 

• To save the Means, File ► Export ► Text file (ASCII) click on “Export current frame” to only get 
the means. If you “Export all frames” you will end up with 200+ text files.  

• Take a screenshot of the means colormap (see below)  
 

 
Appendix A-  10. Prompt output demonstrating mean frame was generated in PIVLab (left) and sample 
mean velocity vector map (right).  
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Play around with the other potential outputs in Plot ► Spatial Parameters 
 
To create a color map, Plot ► Spatial Parameters under display parameter, select Magnitude in m/s 
and click “Apply to current Frame”. To add a color bar and change the color scheme, go to Plot ► 
Modify plot appearance 

 
Appendix A-  11. Modifying plot appearance for PIVLab.  

 
• Take a screenshot of the colormap 

 
Appendix A-  12. Sample PIVLab output colormap. 
 

• To add streamlines Plot ► Streamlines. Click Draw streamlines or draw streamline rake. 
Play around with what looks best. It is a learning process.  
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Appendix A-  13. Sample PIVLab output colormap with streamlines.  
 
 
File ► Save ► PIVLAB session. It is recommended to save the session in the same folder as the images. 
The resulting calculations consist of matrices or vectors of displacement for each pair of analyzed 
images. 
 
You can also output as tecplot and ASCII files. It is recommended, at the very least, to save the means as 
an ASCII file. Also, take screenshots of whatever visual output you are looking to keep.  
 
  



 

 

Appendix B 

New TRiVIA Processing Workflow 
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How to Use TRiVIA  
Resources: https://code.usgs.gov/wma/osd/trivia 
https://www.usgs.gov/software/toolbox-river-velocimetry-using-images-aircraft-trivia  
 

1) Select Input Data Tab  
a. “Select Input data directory” – add folder where video file is located. It will auto 

populate the data directory and the native frame rate  
b. IF USING A VIDEO use the blue dialog boxes. IF USING IMAGES use the 

green dialog boxes.  
i. If using images, make sure to set the capture interval to the inverse of your 

frame rate. For example, if your frame rate is 29.97 frames/second, then 
the capture interval will be 0.03337 seconds. If your frame rate is 59.96 
frames/second, then the capture interval will be 0.01668 seconds 

 
Appendix B- 1. TRiVIA GUI for importing video.  

c. If you are using video, “Preview and subset input data” -> “Video sampling” put 
in offset time of interest. Select “Import image stack from video of PIV analysis  

https://code.usgs.gov/wma/osd/trivia
https://www.usgs.gov/software/toolbox-river-velocimetry-using-images-aircraft-trivia
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Appendix B- 2. TRiVIA pop-up demonstrating processing is complete.  

d. If you are using images, in “Preview and subset input data” -> “Image sequence 
input” set starting image # as 1 and ending image # as the last number in stack, 
assuming you want to keep all images. Select “create final stack”  

 
2) Image preparation tab  

a. Hit “Stabilize images” to populate your images  
i. Note: The crop images button is a LIE and only works if you are 

georeferencing something.  
b. In the “Select Method to define in-channel region of interest (ROI)” window, 

select the Digitize option and click the box for “Create region of Interest for PIV 
analysis”. You will need to left click around the region of interest you want. 
Double left click the last vertex to complete the region. You will see the image 
update with the new region of interest on the right side of the application in the 
Image Preparation window. 

c. In the “Scale factor only” window, click on the “Measure known length on 
image” button. Move the line segment to the known length and double left click 
on one of the line vertices to close this window. Enter the known dimension into 
the Distance box and click the “Calculate pixel size (GSD)” 

d. In the “Cropping and masking” window, click on the “Mask non-georeferenced 
image sequence” to apply the mask to the image series. You can click on 
Visualize raw Stack to see the video play of the images 

e. In the Pre-processing window, choose the image enhancement method. I 
attempted using the FFT bandpass filter option Weiner spatial filter with the 
following default settings for my first try at this: 

 
Appendix B- 3. Pre-processing filter prompt.  

When you have the desired settings selected, click the button for “Enhance 
images” and it will pre-process the image stack. When this process is done, you 
can click on “Visualize pre-processed images” to view the results: 
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Appendix B- 4. TRiVIA output.  

3) PIV analysis tab 
a. In the “PIV input parameters” window, change the desired output vector spacing 

to something smaller than the default value of a meter. Since this application is 
mainly for higher altitude aerial footage, we need a smaller spacing at a closer 
scale with our videos. For this initial attempt, I changed the spacing to 0.1 meters 

i. The tutorial document recommends keeping the Velocity limits, Local 
median threshold, Standard deviation threshold, Vector infilling and 
Vector smoothing to default values as they can be applied to most cases. If 
you want to do more passes of the PIV, you can change this from 1 to 
something greater to get more accuracy. You may need to uncheck vector 
infilling and vector smoothing as this might give an inaccurate vector 
field. 

b. In the “PIV processing” window, click the “Perform PIV” button. 
c. After this process is done running, you can display the final output within 

TRiVIA by clicking “Plot initial output” 
d. You can add streamlines to the output in the “Streamline visualization tool” 

window 
e. When you are done making the figures, you can click on “Select TRiVIA output 

file” in the “Export TRiVIA results” window. The file will contain the x (east) 
and y (north) spatial coordinates of the vector origins in meters and the u (east) 
and v (north) velocity components of the vectors in meters per second. You can 
save this data as a .csv file. You can also try clicking on “Calculate derivatives 
and export” to get more variables like magnitude, vorticity, divergence, shear, 
strain and direction. 
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LSPIV Lit Review For Seeding Material  
Sensitivity study of large-scale particle image velocimetry 
measurement of river discharge using numerical simulation 
Authors: Alexandre Hauet, Jean-Dominique Creutin, Philippe Belleudy 
PDF File Name: 1s2.0S0022169407006518main (1) 
Findings:  

• Pg 182: Used river images and tracked the natural elements in the footage. Some floating 
objects with rigid shape and tracked complex evolving turbulent patterns in the flow 

o Tracers as simple squares randomly on the water surface 
o Tracers influenced by the wind out in the field 
o Sun illuminated tracers for the camera to detect 
o Size and color of tracer unknown, bright enough color to be detected. Likely 

pretty buoyant material to float at the top of the water surface 

 
Capabilities of Large-scale Particle Image Velocimetry to characterize 
shallow free-surface flows 
Authors: M. Muste, A. Hauet, I. Fujita, C. Legout, H.-C. Ho 
PDF File Name: 1s2.0S0309170814000657main_1 (1) 
Findings:  

• “A favorable seeding scenario is when natural tracers float on the free surface. Such 
situations occur when light floating debris, foam, ice blocks are visible at the free 
surface” pg. 163 

• “The present authors tested several environmentally harmless seed materials (e.g. leafs, 
mulch, grass, popcorn), launching approaches (bridges, cranes, confetti machines and 
cannons), and strategies (multipoint seeding points, transecting the flow).” Pg 163 

• “A good candidate for seeding material from multiple perspectives is Eco-foam [8], an 
environmentally friendly packaging material that is more than 95% cornstarch [19,28]. 
This seeding was successfully tested under laboratory and field conditions [23,24]” Pg 
163 

• “The surface flow was visualized by sawdust particles of cypress wood having a mean 
diameter less than 1 mm.” Pg 164 

• “Ground black pepper was selected as surface flow tracer, giving sufficient contrast on 
the white molded surface” Pg 166 
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Large-scale particle image velocimetry for flow analysis in hydraulic 
engineering applications 
Authors: Ichiro Fujita, Marian Muste & Anton Kruger 
PDF File Name: 454455 (1) 
Findings:  

• Air bubbles and tracked their shadows (Pg 406) 
• “Black plastic beads of 2 mm diameter were released for this purpose through several 

injection points located strategically in the dividing wall.” Pg 406 
o Might need smaller diameter particles than this for capturing fine turbulent details 

• For the experiment with ice, they used the model ice and “low concentrations of 3-mm 
diameter block polypropylene beads” for tracking (Pg 408) 

o “For the ice-covered regions, when a continuous layer of black beads covered the 
water free-surface, low concentration of square-shaped (1cm by 1 cm) white 
polypropylene particles were included in the continuous layer, to trace the ice 
flow” Pg 408 
 

River gauging using PIV techniques: a proof-of-concept experiment on 
the Iowa River 
Authors: J.D. Creutin, M. Muste, A.A. Bradley, S.C. Kim, A. Kruger 
PDF File Name: 227068657 (1) 
Findings:  

• Used a naturally occurring foam as a flow tracer created by a waterfall and highly aerated 
flow at the tow of a sill 

• Can use leaves for smaller width rivers 
• Not much was mentioned about the size of the tracer foam. They focused on the 

composition of it with the clays of the river allowing it to form naturally. 
 

Application of large-scale particle image velocimetry (LSPIV) to 
identify flow pattern in a channel 
Authors: Tommy Ekamitra Sutarto 
PDF File Name: Application of Large-Scale Particle Image Velocimetry (LSPIV) to Identify 
Flow Pattern in a Channel 
Findings:  

• Eco-foam was used as the flow tracer particles. Second time this has been mentioned (pg. 
215) 

o “The tracer particles were biodegradable eco-foam peanut which are granular 
packaging materials made of predominantly corn syrup. These particles have low 
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inertia and submergence; therefore, they are able to follow accurately local flow 
movements. The size of the particles was about 2 cm, large enough to be detected 
by the camera” 

o “The density of the seeding material was in the range between 10 and 30 percent 
of the surface area” 

 
Remote Sensing Large‐Wood Storage Downstream of Reservoirs 
During and After Dam Removal: Elwha River, Washington, USA 
Authors: D. Buscombe, J. A. Warrick, A. Ritchie, A. E. East, M. McHenry, R. McCoy, A. 
Foxgrover, and E. Wohl 
PDF File Name: Earth and Space Science - 2024 - Buscombe - Remote Sensing Large‐Wood 
Storage Downstream of Reservoirs During and After Dam 
Findings:  

• This source focused on large woody debris analysis and was doing mainly aerial imagery. 
Nothing was mentioned of LSPIV and seeding particles 

 
Effects of estuarine mudflat formation on tidal prism and large-scale 
morphology in experiments 
Authors: Lisanne Braat, Jasper R. F. W. Leuven, Ivar R. Lokhorst and Maarten G. Kleinhans 
PDF File Name: Earth Surf Processes Landf - 2018 - Braat - Effects of estuarine mudflat 
formation on tidal prism and large‐scale 
Findings:  

• Floating plastic particles used to obtain surface water velocities (pg. 420) 
o Did not talk about the size of these particles or any other characteristics of them 

• Focused on mud primarily 

 
A framework to facilitate development and testing of image-based 
river velocimetry algorithms 
Authors: Carl J. Legleiter and Paul J. Kinzel 
PDF File Name: Earth Surf Processes Landf - 2024 - Legleiter - A framework to facilitate 
development and testing of image‐based river 
Findings:  

• Numerical model called SHIVER that used the following particle parameters: 
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Appendix C - 1. Particle parameters used in numerical model.  
• Nothing else is said about the seeding particles they used in the program 

 
THE REMOTE MONITORING OF SURFACE VELOCITY, BATHYMETRY 
AND DISCHARGE IN RIVERS AND OPEN CHANNEL FLOWS 
Authors: Erika D. Johnson 
PDF File Name: edj28 
Findings:  

• Small buoyant particles 
• Small Stokes number (St# = 0.003) 
• “The particles that were imaged in these experiments were Pliolite VTAC-L particles, 

which are manufactured by OMNOVA. While these particles have a mean specific 
gravity of 1.03, there is a distribution of individual particle density, as evidence by their 
behavior in water. Particles that float were preferentially selected for use in the 
experiments. The particles were sifted between a series of sieves and only particles in the 
range 420 - 600 microns (0.42 – 0.6 mm) were used in this study.” (pg. 23) 

 
Growing Forced Bars Determine Nonideal Estuary Planform 
Authors: J. R. F. W. Leuven, L. Braat, W. M. van Dijk, T. de Haas, E. P. van Onselen, B. G. 
Ruessink, and M. G. Kleinhans 
PDF File Name: JGR Earth Surface - 2018 - Leuven - Growing Forced Bars Determine Nonideal 
Estuary Planform 
Findings:  
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• Used white floating particles with 2.5 mm diameter (pg. 2976) 
• Nothing else has been mentioned for the description of the particles 

o White seems to be a common color for the particles so the camera can track them 

 
Incipient Tidal Bar and Sill Formation 
Authors: J. R. F. W. Leuven and M. G. Kleinhans 
PDF File Name: JGR Earth Surface - 2019 - Leuven - Incipient Tidal Bar and Sill Formation 
Findings:  

• “White polystyrene particles (diameter approximately 2.5 mm) on the water surface” pg. 
1766 

• Nothing else mentioned for the parameters of the particle 

 
Experimental System for Real-Time Discharge Estimation Using an 
Image-Based Method 
Authors: Alexandre Hauet; Anton Kruger; Witold F. Krajewski; Allen Bradley; Marian Muste; 
Jean-Dominique Creutin; and Mark Wilson 
PDF File Name: 
krugeretal2008experimentalsystemforrealtimedischargeestimationusinganimagebasedmethod 
Findings:  

• Waterfall created foam which acted as a tracer for the LSPIV study (pg. 2) 
• Typical size of the aggregates of foam was about 5m and distance between the aggregates 

was 10m (pg. 2) 
o This was another instance of natural foam being used as a tracer 

 
Defining the Limits of Spectrally Based Bathymetric Mapping on a 
Large River 
Authors: Carl J. Legleiter and Ryan L. Fosness 
PDF File Name: remotesensing-11-00665-v3 
Findings:  

• Does not really mention the tracer used. This was a suspended sediment study and some 
of the data related to it can be found on page 7 in table 1 

 
Large-scale particle image velocimetry for measurements in riverine 
environments 
Authors: M. Muste, I. Fujita, and A. Hauet 
PDF File Name: Water Resources Research - 2009 - Muste - Large‐scale particle image 
velocimetry for measurements in riverine environments 
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Findings:  
• Mentions foam, leaves, or artificial seeding can be added to surface for collecting 

measurements (pg. 4) 
• Pg 9, “vigorous kolks, boils, and ripples generated by the large-scale turbulent eddies 

moving over the bed forms and roughness will be observable at the free surface. These 
free surface perturbations act as reflectors of the sun or other dominant ambient light 
playing the role of natural seeding for the LSPIV measurements” 

• Pg 9, “second type of tracer that can occur naturally during floods is created by large-
scale turbulent eddies entraining sediment throughout the flow depth” 

o Creates sediment clouds 
• Third type is floating debris carried by the stream (pg. 9) 
• Study used “biodegradable packaging particles” pg. 9 

 

Appendix C - 2. Table from article showing technique and seeding type tested.  
• Page 11 

 
Remote monitoring of volumetric discharge employing bathymetry 
determined from surface turbulence metrics 
Authors: E. D. Johnson and E. A. Cowen 
PDF File Name: Water Resources Research - 2016 - Johnson - Remote monitoring of volumetric 
discharge employing bathymetry determined from (1) 
Findings:  

• “The laboratory flow is seeded with small buoyant Pliolite VTAC-L particles. The 
particles have a specific gravity, SG 5 qi/q 5 1.03, where qp is the particle density, and 
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were sieved to a particle diameter (dp) range of 0.42–0.60 mm. The particle Stokes 
number is small,” (Page 7) 

o Passive tracers 
o Second time this type of seeding material was used, but both are from same 

author. Must have worked well enough to be used multiple times. 

 
Remote Sensing of River Bathymetry: Evaluating a Range of Sensors, 
Platforms, and Algorithms on the Upper Sacramento River, California, 
USA 
Authors: Carl J. Legleiter and Lee R. Harrison 
PDF File Name: Water Resources Research - 2018 - Legleiter - Remote Sensing of River 
Bathymetry Evaluating a Range of Sensors Platforms 
Findings:  

• Does not mention LSPIV and seeding material, mainly a LiDAR study 
• Does have information on the suspended sediment sizing they looked at (page 11)  
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